
Infor VISUAL Cash User’s Guide



Copyright © 2020 Infor

Important Notices
The material contained in this publication (including any supplementary information) constitutes and contains confiden-
tial and proprietary information of Infor.

By gaining access to the attached, you acknowledge and agree that the material (including any modification, transla-
tion or adaptation of the material) and all copyright, trade secrets and all other right, title and interest therein, are the 
sole property of Infor and that you shall not gain right, title or interest in the material (including any modification, trans-
lation or adaptation of the material) by virtue of your review thereof other than the non-exclusive right to use the mate-
rial solely in connection with and the furtherance of your license and use of software made available to your company 
from Infor pursuant to a separate agreement, the terms of which separate agreement shall govern your use of this 
material and all supplemental related materials ("Purpose").

In addition, by accessing the enclosed material, you acknowledge and agree that you are required to maintain such 
material in strict confidence and that your use of such material is limited to the Purpose described above. Although 
Infor has taken due care to ensure that the material included in this publication is accurate and complete, Infor cannot 
warrant that the information contained in this publication is complete, does not contain typographical or other errors, or 
will meet your specific requirements. As such, Infor does not assume and hereby disclaims all liability, consequential or 
otherwise, for any loss or damage to any person or entity which is caused by or relates to errors or omissions in this 
publication (including any supplementary information), whether such errors or omissions result from negligence, acci-
dent or any other cause.

Without limitation, U.S. export control laws and other applicable export and import laws govern your use of this material 
and you will neither export or re-export, directly or indirectly, this material nor any related materials or supplemental 
information in violation of such laws, or use such materials for any purpose prohibited by such laws.2020

Trademark Acknowledgements
The word and design marks set forth herein are trademarks and/or registered trademarks of Infor and/or related affili-
ates and subsidiaries. All rights reserved. All other company, product, trade or service names referenced may be regis-
tered trademarks or trademarks of their respective owners.

Publication Information
Release: Infor VISUAL 10.0.0

Publication date: November 17, 2020



Contents
Contents

Chapter 1: Cash Book ....................................................................................................................1–1

Introducing Cash Book .....................................................................................................................1–2

Starting Cash Book.....................................................................................................................1–2

Getting Started with Cash Book .................................................................................................1–2

Adding Adjustments..............................................................................................................1–4

Editing Adjustment Transactions ..........................................................................................1–5

Deleting Adjustment Transactions........................................................................................1–6

Posting A/R and A/P Transactions to the General Ledger .........................................................1–6

Posting Cash Book Adjustments to the General Ledger ............................................................1–6

Viewing Batch Information..........................................................................................................1–7

Clearing Transactions in Cash Book ..........................................................................................1–8

Reconciling Cash Book...................................................................................................................1–10

Printing the Cash Book Report .......................................................................................................1–11

Printing G/L Transactions .........................................................................................................1–11

Printing the Payment Register ..................................................................................................1–13

Printing the Bank Statement Reconciliation Report..................................................................1–14

Chapter 2: Cash Management .......................................................................................................2–1

Cash Management Overview ...........................................................................................................2–2

Properties ...................................................................................................................................2–2

Categories ..................................................................................................................................2–2

Cash Plan Categories...........................................................................................................2–2

Calculation Sequences...............................................................................................................2–3

Starting the Cash Management Window ..........................................................................................2–4

Adding Cash Categories.............................................................................................................2–4

Editing Cash Categories.......................................................................................................2–5

Existing Cash Management Plans .................................................................................2–6
Cash Management Plan In-process ...............................................................................2–6

Calculating Cash Plans for Actual Cash Activity ........................................................................2–6

Calculating Cash Plan Projection Assumptions..........................................................................2–8
Infor VISUAL Cash Management User’s Guide | Contents – i



Contents
Viewing the Cash Plan Graph.........................................................................................................2–12

Printing Cash Plan Reports ............................................................................................................2–13

Printing Cash Plan Reports ......................................................................................................2–13

Printing Pay Performance Reports ...........................................................................................2–13

Printing Shipment Performance Reports ..................................................................................2–14

Printing Receipt Performance Reports .....................................................................................2–15

Chapter 3: Bank Account Maintenance ........................................................................................3–1

Starting Bank Account Maintenance.................................................................................................3–2

Adding Bank Accounts ...............................................................................................................3–2

Editing Bank Account Information ..............................................................................................3–3

Deleting Bank Accounts .............................................................................................................3–4

Specifying User Dimensions.............................................................................................................3–5
ii – Contents | Infor VISUAL Cash Management User’s Guide



Cash Book
Chapter 1: Cash Book

Cash Book is a bank account management tool. All of the cash transactions from Accounts Payable 
Payment Entry and Accounts Receivable Cash Application are collected in Cash Book to facilitate 
your bank reconciliation. You can also manually enter adjustment transactions to the bank account, 
such as bank interest, fees, transfers, and automatic deposits and withdrawals in Cash Book.

This chapter includes: 

Topic Page

Introducing Cash Book ................................................................................................................... 1–2

Starting Cash Book......................................................................................................................... 1–2

Getting Started with Cash Book...................................................................................................... 1–2

Posting A/R and A/P Transactions to the General Ledger .............................................................. 1–6

Posting Cash Book Adjustments to the General Ledger................................................................. 1–6

Clearing Transactions in Cash Book............................................................................................... 1–8

Reconciling Cash Book................................................................................................................. 1–10

Printing the Cash Book Report ......................................................................................................1–11

Printing G/L Transactions...............................................................................................................1–11

Printing the Payment Register ...................................................................................................... 1–13

Printing the Bank Statement Reconciliation Report ...................................................................... 1–14
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Introducing Cash Book
Introducing Cash Book
Accounts Payable payments and Accounts Receivable receipt transactions are automatically added 
to Cash Book when you post them to the General Ledger. Use Cash Book to reconcile your bank 
statements after you have entered your manual adjustments for the month, the transactions are 
accumulated. The General Ledger Balance and the corresponding Check Register Balance must 
reconcile.

Use the Cash Book window to view the transactions from Cash Application in Accounts Receivable 
and Payment Entry in Accounts Payable and to enter manual adjustments to the bank accounts (i.e. 
interest and fees).

Daily deposits are remitted to the bank in batches that appear on your Bank Statement for 
reconciliation. These should coincide with the batches that you receive through the period. Keeping 
those batches synonymous with your Check Register makes reconciliation easier. Cash Book gives 
you the capability to assign checks to a Deposit ID, create a deposit, and view deposit details. Any 
differences between the value posted to Cash Book from the bank statement are applied directly on 
the Cash Book line. The difference is automatically updated to the cash account.

Cash Book works with Bank Account Maintenance, tracking Bank Transfers and Charges in both the 
system currency as well as Multi-Currency. The functionality is incorporated to be fully Euro 
compliant. You are able to track receipts as well as expenditures of different currencies. Transaction 
currency cash receipts and/or payments are converted to bank account currency. Refer to Chapter 3, 
“Bank Account Maintenance” for more information.

Starting Cash Book
Cash Book is available from the Main menu under Cash.

Select Cash, Cash Book from the main menu.

Getting Started with Cash Book
The Cash Book displays all the cash transactions generated from A/P payments and A/R cash 
applications. You can access each Bank Account ID in the database through Cash Book; however, 
you can only reconcile one Bank Account ID at a time.

1 In the Cash Book window, click the Browse button beside the Bank Account ID field to select an 
Account ID from the list, or enter the Bank Account ID in the field provided.

2 To view transactions for particular sites, select the appropriate check boxes in the Cash 
Management Site ID(s) drop-down list. You can select any site that is allowed to use the Bank 
Account ID you specified. A site is allowed to use a bank account if the site's parent entity is 
defined as the entity ID for the Bank Account ID in Bank Account Maintenance.
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Introducing Cash Book
After you specify a bank account ID and sites, the cleared balances and account balances for the 
bank account ID are calculated and inserted in the header. Only transactions made in the sites 
and dates that you specified are used to calculate the balances. The individual transactions for 
the bank account ID in the sites you specified are inserted in the table.

The original date of each transaction, the description of each transaction, (Accounts Receivable 
deposit, Accounts Payable payment or an adjustment entered directly, and a cleared check box 
for each transaction) if selected, indicates that the transaction has cleared the bank. The amount 
of each transaction (payment, adjustment, or deposits) and the cumulative amount for the bank 
account are shown by line. If you are using multi-currency, the native currency amount appears in 
the Currency Amount column.

3 Click the Calendar button and select the Start Date, or enter the Start date in the Start Date field.

This date is the original date of the transaction. For Accounts Payable payments, this is the print 
date of the payment. For Accounts Receivable deposits, this is the deposit date you specify. For 
adjustments in Cash Book, this is the date you specify when you add the adjustment.

The Start and End dates of the current system date period are the defaults. To view all uncleared 
transactions up to the end of the period, clear the Start Date field. If you clear both the Start Date 
field and the End Date field, all uncleared payment transactions appear.

To selectively view transactions for the month you want to reconcile, select a new Start date. Only 
cleared transactions for that specific period and subsequent are displayed.

For example, if you are currently reconciling January and there are also transactions for February, 
and you request a Start Date of December, all transactions for December, January and February 
are displayed.

4 Click the Calendar button beside the End Date field and select an End Date, or enter the End 
date in the field provided.

This is the end or cut off date that is used to select the transactions.

5 You can choose the sort sequence you want by clicking the appropriate option in the Sort section 
(by date or by payment number).

6 To display only cleared items, click the Show Cleared check box in the Display section.

To display all items, leave the check box checked for Show Cleared Bank.

The Date Cleared column denotes the date the item cleared the bank statement.

7 To open items (payments or deposits) and view them in their “native” (original) context, double-
click the line. 

You are prompted to confirm if you want to open the selected line item.

8 Click the Yes button to open the item, or the No button to return to the previous window without 
opening the item.

The original A/P Payment Entry invoice (voucher) is opened.

9 To view existing Deposit IDs, click the View Deposits toolbar button, or select Edit, View 
Deposits from the menu.
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Introducing Cash Book
The list of Deposit IDs appear. You can make a selection from the list. This function gives you the 
ability to view deposit details however, you cannot make edits. You can automatically assign a 
Deposit ID to all cash receipts; this eliminates the need to allow the subsequent attachment at a 
later date. 

To use an existing ID, enter that ID in the Deposit ID column.

10 Enter any non A/P or A/R related cash transactions.

Typical examples include bank service charges, interest and/or transfers, and automatic 
withdrawals/deposits. These transactions are known as Bank Adjustments in the Cash Book.

Adding Adjustments

Bank account adjustments create journal postings based on the information entered in the adjustment 
dialog box. After you have entered the adjustments, you need to post them to the General Ledger 
using the Post adjustments to G/L menu option.

1 In the Cash Book window, click the Browse button beside the Bank Account ID field to select the 
Bank Account ID you want from the list, or enter the Bank Account ID in the field provided. 

2 From the Edit menu, select Add Adjustment.

3 Enter the appropriate information in the following fields:

Date – Click the Calendar button to select a date, or enter the date in the field provided.

Adjustment ID – Specify an identifier for this transaction.

Amount – Specify the amount of the transaction adjustment.

Reference – Enter a description for the adjustment.

Deposit Number – The Deposit Number field is automatically populated.

Cash Management Site ID – If you are licensed to use multiple sites, click the Cash Mgmt Site 
ID arrow and select the site that processes the transaction. You can choose any site that belongs 
to the accounting entity associated with the bank account you selected in the Cash Book window. 

The site you specify in the Cash Mgmt Site ID field can manage transactions for sites, provided 
that all sites involved in the transaction share at least one common tracking currency. Tracking 
currencies are defined at the accounting entity level.

Exchange Rates – Click the Exchange Rates button to select an exchange rate, or enter the 
exchange rate in the field provided.

The Adjustment and Reference fields are used as the Reference description for the detail item in 
the Cash Book window.

The Posting Info, Batch ID, and Date Posted are populated from the main Cash Book window.

Type – Select how this adjustment is to affect the bank account. Choose from Credit or Debit. As 
an example, bank interest would be a debit to the bank account.
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Introducing Cash Book
User Dimensions – If you are using user dimensions, the dimension ID associated with the Bank 
ID you selected before accessing the Adjustments dialog box is inserted. If you are entering a 
debit adjustment, then the debit dimension ID for the bank is inserted. If you are entering a credit 
adjustment, then the credit dimension ID for the bank is inserted.

You can override the dimension IDs. 

Cust Order ID – Optionally, click the Cust Order ID browse button to select a customer order to 
associate with this line. You can view transactions associated with the customer order ID you 
specify in the General Journal by Dimension dialog box available in the Accounting Window.

Product Code – Click the Product Code browse button and select a product code in which to 
associate to this transaction line. You can view transactions associated with the product code you 
specify in the General Journal by Dimension dialog box available in the Accounting Window.

4 Click the Insert button to insert a new row.

5 Specify this information:

Specify the G/L Account ID (offsetting account) to which you are posting this transaction. The G/L 
Account Description is automatically populated in the G/L Account Description field.

You can separate adjustment amounts to various offsetting accounts.

Specify the Amount in the amount field. 

6 To automatically add another row, TAB past the last field in the row, or click the Insert button 
again.

Click the Clear button to clear all information in the Adjustments dialog box.

7 To delete a row, highlight the item, then click the Delete button.

8 Click the Ok button to add the adjustment.

Click the Cancel button to exit the Adjustments dialog box without adding an adjustment.

9 If you clicked the OK button, the Cash Book window is re-displayed and the transactions are 
placed in the correct order, sequenced by date. The Account Balance for the account is updated 
automatically to reflect the adjustment you added.

Editing Adjustment Transactions

You can edit the adjustment transactions you create until you post them to the ledger. After you post 
the adjustment to the general ledger, you cannot edit it. Any changes you make to adjustment 
transactions are automatically updated to the table.

1 On the Cash Book window, highlight the transaction line you want to edit. 

2 From the Edit menu, select Edit Adjustment. 

The Adjustment dialog box appears. 

3 Make any changes to the information on the Adjustment dialog box. 

4 Click OK to save the changes. 
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Introducing Cash Book
Deleting Adjustment Transactions

You can delete adjustment transactions as long as you have not posted them to the ledger. After the 
transactions are posted you cannot delete them.

To delete an unposted adjustment:

1 Highlight the transaction line in the Cash Book window, then from the Edit menu, select Delete 
Adjustment. 

A message box appears, prompting you to confirm the deletion of the selected adjustment. 

2 Click Yes to confirm the deletion or click No to cancel it. 

If you select Yes, the line is cleared from the table. The adjustments are automatically maintained 
to the total fields as you make changes to the Cash Book window.

Posting A/R and A/P Transactions to the General Ledger
When you are preparing to reconcile the bank statement for the month, ensure that you have posted 
all the transactions generated from Accounts Receivable and Accounts Payable to the General 
Ledger.

You can quickly access both the windows you need to use from the File menu.

Select Receivables, Cash Application to post Accounts Receivable deposits.

The A/R Cash Application window appears. See “Cash Application” on page 5-1 in the Financials 
Accounts Receivable book.

Select Payables, Payment Entry to post Accounts Payable checks.

The A/P Payment Entry window appears. See “A/P Payment Entry” on page 5-1 in the Financials 
Accounts Payable book. 

Optionally, select Close/Reopen Account Period for unposted transactions.

Posting Cash Book Adjustments to the General Ledger
After you enter all your adjustments to the Cash Book, you need to post them to the General Ledger. 
You post through the Post Adjustments to G/L function available from the File menu of the Cash 
Book window. This posts all the adjustments you enter for all bank accounts. You have the option of 
posting only your adjustments or all the outstanding adjustments for all users.

To post your adjustments:

1 Select File, Post Adjustments to G/L from the menu.

2 If you are licensed to use multiple sites, click the Site ID arrow and select the site for which you 
are posting distributions to the general ledger. If you are licensed to use a single site, this field is 
unavailable.
1 – 6 | Infor VISUAL Cash Management User’s Guide 



Introducing Cash Book
3 The One Tx per Batch check box is read-only. It indicates whether the One Tx per Batch check 
box is selected or cleared in Accounting Entity Maintenance. If the check box is selected, then 
each batch will contain only one transaction. If the check box is not displayed, then the batch will 
contain all transactions in the posting run. Specify the setting to use in Accounting Entity 
Maintenance.

4 Click the Calendar button beside the Batch Date field to select a Batch Date, or enter the Batch 
Date in the field provided.

This is used as the date for the batch of adjustment transactions that are created. When you tab 
out of the field, the month and year of the accounting period in which the date falls are filled in.

5 If you want to process all adjustments, clear the Current User Only check box.

6 Click the Start button to begin processing.

You can view the transactions before posting the batch to the ledger.

Viewing Batch Information
You can information about the batch used to post an adjustment. 

1 In the Cash Book table, select a row that contains an adjustment.

2 Select View, View Batch Information. 

You can use the Previous and Next buttons to move between batches. 

The Entry Date, Accounting Period, Site ID, Description, and Batch Type information are 
automatically populated. 

This information is displayed in the table: 

Trans ID – The Transaction ID is a simple line number that is used as a reference for the 
transaction detail line. 

G/L Account ID – The G/L Account ID indicates the ID for the account associated with the debit 
or credit transaction within the Journal Batch.

G/L Account Description – This is a brief description of the G/L Account. This information comes 
from the Account table. You can modify the Account Description within the Accounting Window.

Site ID – The Site ID indicates the site in which the transaction was made. 

Debit – The Debit column indicates the amount, in the transaction currency, that the current 
transaction line withdraws from the Account on the current line.

Credit – This column indicates the amount, in the transaction currency, that the current 
transaction line deposits into the Account on the current line. 

Reference – The Reference column contains any reference information that you entered on the 
original Journal Entry line. 

Currency ID – This column indicates the ID for the transaction currency. 

Native – This column indicates whether the currency is a Native or Non-Native currency. If it is 
native, this column contains a Y. If it is non-native, the column indicates N.
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Introducing Cash Book
3 To view transactions for a specific currency, select the currency from the Display Currency drop-
down list. 

4 To exit the Batch Information dialog box, click Close.

Clearing Transactions in Cash Book
After you have accumulated all the transactions for the month in Cash Book, you are ready to 
compare your bank statement with your Cash Book transactions to determine what has cleared. 
When you determine that a transaction has cleared, use the procedure below to report it to the Cash 
Book. Cleared Balance and Account Balance totals are displayed, as well as dollar amounts for 
Displayed records and for the Entire account. When records are marked as Cleared, the Cleared 
Balance field displays the adjusted value.

1 Click the Browse button beside the Bank Account ID to select an ID from the list, or enter the 
Bank Account ID for the account you want to reconcile in the Bank Account ID field.

2 Click the Cash Mgt Site ID(s) drop-down menu and select the sites to include in the table. You can 
select any site that is allowed to use the Bank Account ID you specified. Transactions for the sites 
you select are inserted in the table. Select **All** to view transactions for all sites that are allowed 
to use the Bank Account ID.

3 Enter the Start date and End date directly or use the Calendar button to make your selections in 
the appropriate fields.

The appropriate data fields are populated.

4 To indicate that a single transaction has cleared the bank, select the item you want cleared, then 
click the Set Cleared toolbar button, or select the check box in the Cleared column for the 
transaction line.

A check mark appears, indicating a cleared transaction.

To undo the check box in the Cleared column, click the check box again, or click the Set 
Uncleared toolbar button. This returns the transaction to an uncleared status. 

To mark multiple transactions as cleared at the same time, highlight the lines and click the Set 
Cleared toolbar button.

Check marks appear in the Cleared check box for all the selected lines.

To deselect multiple lines cleared, highlight the lines and click the Set Uncleared toolbar button. 
This returns the multiple transactions to an uncleared status.

As you mark transactions as Cleared or Uncleared, the Cleared Balance total field is dynamically 
updated as compared to the Account balance field.

The Date Cleared column displays the date in which the item cleared the bank statement.

To open items in their “native” context, double-click on it. 

5 Click the Save button to save your changes.

The changes you have made are saved to the bank account. Your next step is to reconcile your 
Cash Book to your bank statement.
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Introducing Cash Book
You can click the Clear button at any time before clicking on Save to remove all the changes you 
have made.
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Reconciling Cash Book
After you have posted all A/P, A/R, and adjustment transactions for a bank account, you are ready to 
reconcile Cash Book to your bank statement.

1 Click the Browse button beside the Bank Account ID field to select an ID from the list, or enter the 
Bank Account ID in the field provided.

2 Click the Cash Mgt Site ID(s) drop-down menu and select the sites to include in the table. You 
can select any site that is allowed to use the Bank Account ID you specified. Transactions for the 
sites you select are inserted in the table. Select **All** to view transactions for all sites that are 
allowed to use the Bank Account ID.

3 Click the Reconcile toolbar button, or select Edit, Reconcile from the menu.

If this is the first time the reconciliation has been done, the Statement Starting Balance field 
appears blank and calculates at $0.00. Later reconciliations will carry the ending balance over 
from the previous reconciliation process.

4 In the Statement Ending Balance field, enter the ending balance from your bank statement.

The difference between the bank’s balance and your Cleared Balance is calculated and this value 
is entered in the difference field. The value is based on the difference between the beginning and 
ending balance. This value changes as the items clear.

5 If a difference exists, attempt to rectify it by rechecking the cleared items.

You can change the Cleared status of a transaction line in the Cash Book window without closing 
the Reconcile dialog box. You can click the Cleared check box to change the status (to 
Uncleared) of an individual transaction. Or if you need to include or exclude a group of 
transactions, you can highlight the rows, then click the Set Cleared or Set Uncleared button.

As you change the Cleared status of transactions in the Cash Book window, the totals in both the 
Cash Book window and the Reconcile dialog box are dynamically adjusted. The following two 
fields in the Reconcile dialog box reflect the changes you just made while displaying both 
windows.

Payments, debits – the number field reflects how many additional payment-type transactions 
you included as cleared (the count decrements if you remove the Cleared status). The amount 
field is the sum of payment-type transactions you cleared.

Deposits, credits – the number field reflects how many additional deposit-type transactions you 
included as cleared (the count decrements if you remove the Cleared status). The amount field is 
the sum of deposit-type transactions you cleared.

You can stop and restart the reconciliation process without incident. You can review prior 
reconciliations. You begin the process by entering the appropriate bank statement date.

When the value of the Difference field is $0.00, you are done reconciling this account.

6 Click the Start button.

This procedure updates the database for those items that have been cleared.

Reconcile each bank account individually. Be sure to reconcile all accounts. You can now 
continue with the next bank account, if necessary.
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Printing the Cash Book Report
You can print the Cash Book report at any time, but it is most useful after you have finished the 
reconciliation process.

1 Click the Browse button beside the Bank Account ID field to select the Bank Account information 
you want to print, or enter the Bank Account ID in the field provided.

2 Click the Cash Mgt Site ID(s) drop-down menu and select the sites to include in the table. You can 
select any site that is allowed to use the Bank Account ID you specified. Transactions for the sites 
you select are inserted in the table. Select **All** to view transactions for all sites that are allowed 
to use the Bank Account ID.

3 Select File, Print Cash Book from the menu.

4 Click the arrow to select one of the following output types.

Print – Select Print to output the report to your printer.

Click the Print Setup button to view a window that allows you to select a printer and to customize 
your print output options.

View – Select View to output the report to display on your monitor to see what the output will look 
like before you print it. When the information appears on the screen, you can scroll through it and 
then print if a hard copy is needed.

File – Select File to output the report to a text file. You can then edit the report outside using any 
text editor.

E-Mail – Select this option to send the report as a rich text (.RTF) attachment through Microsoft 
Outlook.

5 Click the Ok button to print the report.

The Cash Book report is based on the Bank Account ID and Start date that appears in the Cash 
Book window. The report only shows those transactions from the date that appears in the Start 
Date field forward. To see all transactions, set the Start Date to the oldest date in the database 
that has transactions for the current Bank Account.

This report is helpful to track outstanding checks.

6 Click the Close button to return to the Cash Book window.

Printing G/L Transactions
The Print G/L Transaction report feature is available for printing from the File menu.

1 Select File, Print G/L Transactions from the menu.

2 Do one of these steps:

• To print a standard report, click the Standard tab, and specify this information:
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Printing the Cash Book Report
Site ID – If you are licensed to use multiple sites, click the Site ID arrow and select the site for 
which to view G/L Transactions. If you are licensed to use a single site, this field is 
unavailable.

By Accounting Period – Click this option to generate the report by accounting period. If you 
click this option.

End Date of Accounting Period – Click the Calendar button to select any date within an 
accounting period, or enter the end date in the field provided.

The ending date of the accounting period is automatically determined.

Fiscal Period – The fiscal period is entered when an end date is selected. 

By Batch ID – Click this option to generate the report by Batch ID.

Starting Batch ID – Click the Browse button to select the starting batch ID, or enter the 
starting batch ID in the field provided.

Ending Batch ID – Click the Browse button to select the ending batch ID, or enter the ending 
batch ID in the field provided.

• To print an advanced report, click the By Accounting Period option, then click the Advanced
tab. Specify this information:

Report Calendar ID – Click the Report Calendar ID arrow and select the reporting calendar 
to use for the report. 

Fiscal Year – Click the Fiscal Year browse button and select the fiscal year for the report. 

Site ID(s) – Click the Site ID(s) arrow and select the sites to include in the report. When you 
select multiple sites, shared tracking currencies are identified and inserted in the Report 
Currency field. If a shared tracking currency does not exist, “Not Available” is inserted in the 
Report Currency field. If “Not Available” is displayed, clear site selections until a shared 
currency can be identified.

3 Click the arrow beside the Report Currency ID to select a currency from the list. If you are printing 
a standard report, the entity currency associated with the site is inserted. If you are printing an 
advanced report and are printing the report for multiple sites, the drop-down list shows the 
tracking currencies shared by the selected sites. If no shared tracking currencies are found, “Not 
Available” is inserted. You cannot run the report if a shared tracking currency is not found. Clear 
site selections until a shared tracking currency ID is displayed in the drop-down list.

4 Choose the output destination by clicking the arrow and selecting one of the following:

Print – Select this option to output the file to a printer.

View – Select this option to see what the print output will look like before it is printed.

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-Mail – Select this option to send the report as a rich text (.RTF) attachment through Microsoft 
Outlook.

5 Select the Current User Only check box to print those transactions entered by the current user, 
or leave the box unchecked to print all G/L transactions.

6 Select the order of the items on the report in the Sequence section.
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If you chose to print By Accounting Period, choose from By G/L Account ID, or By Bank Account 
ID, Adjustment ID.

If you chose to print By Batch Number, choose from By G/L Account ID, By Bank Account ID, 
Adjustment ID, By Batch, G/L Account ID, By Batch, Bank Account ID.

7 Select whether to print posted or unposted transactions in the Transactions section.

If you are using the report to check transactions prior to posting, be sure to click the Unposted 
Txs radio button. When printing by Batch Numbers, only the Print Posted Txs option is available.

8 Click the Print Setup button to modify printer options.

9 Click the Ok button.

If you select Print as the output type, a standard Windows printer dialog box appears.

Make the appropriate selections, then click the Ok button.

Printing the Payment Register
The Print Payment Register report feature is available for printing from the File menu.

1 Select File, Print Payment Register from the menu.

2 Click the arrow to select a Bank Account ID from the list, or leave the account at the default 
(**All**) to print all payments. If you select **All**, all banks must belong to entities that share at 
least one tracking currency. If your all of your banks do not belong to entities that share at least 
one tracking currency, you cannot run the report for all banks.

3 Click the arrow to select a currency from the list. If you are printing a report for a single bank 
account, you can select any currency that is used by the entity associated with the bank. If you 
are printing a report for all bank accounts and you use multiple entities, you can select any 
currencies shared in common by the entities associated with the banks. If no shared common 
currencies are found, “Not Available” is inserted. You cannot run the report if a common currency 
is not found.

4 Click the Calendar button beside the Starting Date field to enter a starting date, or enter the 
starting date in the field provided.

5 Click the Calendar button beside the Ending Date field to enter an ending date, or enter the 
ending date in the field provided.

6 Enter the Starting payment number and the Ending payment number to be printed in the 
appropriate fields.

If you want to print all payments within the specified Bank Account ID, leave the fields blank.

7 Select any of the following options you want to include in the Payment Register report.

• Print Cleared Payments

• Print Uncleared Payments

• Print Void Payments

8 Select one of the following options in the Sort By section.
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• Control Number

• Payment Number

9 Choose the output destination by clicking on the arrow and selecting one of the following:

Print – Select this option to output the file to a printer.

View – Select this option to see what the print output will look like before it is printed.

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-Mail – Select this option to send the report as a rich text (.RTF) attachment through Microsoft 
Outlook.

10 Click the Ok button.

Click the Cancel button to exit the dialog box without printing the report.

Click the Print Setup button to modify printer options.

11 If you select Print as the output type, a standard Windows printer dialog box appears.

Make the appropriate selections, then click the Ok button.

Printing the Bank Statement Reconciliation Report
The Print Bank Statement Reconciliation report feature is available for printing from the File menu.

1 Select File, Print Bank Statement Reconciliation from the menu.

2 Click the arrow beside the Bank Account ID field to select an account ID from the list.

3 Click the arrow beside the Statement Date field to select the statement date from the list.

4 Click the arrow to select one of the following output types:

Print – Select this option to output the file to a printer.

View – Select this option to see what the print output will look like before it is printed.

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-Mail – Select this option to send the report as a rich text (.RTF) attachment through Microsoft 
Outlook.

5 Click the Ok button.

Click the Cancel button to exit the dialog box without printing the report.

Click the Print Setup button to modify printer options.
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Cash Management
Chapter 2: Cash Management

You can use the Cash Management Window to manage cash flow and make critical decisions. The 
Cash Management Window is used to organize actual cash flow, predict cash flow for future periods 
based on a set of planning assumptions, and provide a forecasting mechanism to build business 
speculation into the plan. Each plan can be site-specific, currency-specific, and user-definable. It also 
provides tools to make cash budgets easy to understand.

The Cash Management window has the following features:

• User-definable Properties

• User-definable Categories using the “Wizard”

• Summary of Actual Cash Flow

• Projection of Cash based on Current Contacts

• Editable Forecast

• Integrated Graphical Presentation

This chapter includes: 

Topic Page

Cash Management Overview ......................................................................................................... 2–2

Starting the Cash Management Window ........................................................................................ 2–4

Adding Cash Categories................................................................................................................. 2–4

Viewing the Cash Plan Graph....................................................................................................... 2–12

Printing Cash Plan Reports .......................................................................................................... 2–13
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Cash Management Overview

Properties
Each Cash Plan has defined properties.

• Financial Calendar ID – The ID of the financial calendar you want to use for the plan.

• Site ID(s) – If you are licensed to use multiple sites, all sites associated with the financial calendar
ID are included in the plan. To select specific sites, edit the cash plan properties. If you are
licensed to use a single site, this field is unavailable.

• Beginning Balance – Beginning Balance is the beginning cash balance for the first period you
plan.

• Currency ID – You can leave the Currency ID empty (null) to calculate for all currencies. All
currencies are converted to the default entity currency, or if you specify the Currency ID for the
Plan, all calculations (actual and projected) include only the activity for that currency.

You can edit properties. If you edit properties, you need to recalculate so that the cash plan reflects 
amounts specific to the new or different properties.

Categories

Cash Plan Categories

After you define the plan properties, define categories to organize your user-specific presentation, 
called Cash-Into. Specify for each category, a direction of monies, in or out, and a G/L Account.

• Each plan MUST include one Incoming Cash Default Category for Other Accounts and one
Outgoing Cash Default Category for Other Accounts. This ensures that the Total Cash-In and the
Total Cash-Out is correct. These two default categories are not linked to G/L accounts. If these
two categories are not set up, a “A category cannot be found for all cash” error results.

• Cash-In and Cash-Out categories identify the cash source from a sequence of searches.

• Cash-In categories identify the Cash-In source. Cash-In from the Customer Orders (i.e. Revenue
/ G/L Accounts) is first identified. Following the search order, Cash-In from the Accounts
Receivable account is identified, and then from the Bank Account. Finally, if you have not set up
the prior categories on the Cash Plan, the Cash-In defaults to the Category for Other Accounts.

• Cash-Out categories identify the Cash-Out source. Cash-Out from the WIP Inventory Accounts
(work orders that are linked to purchase orders) is first identified. Following the search order,
Cash-Out from the Purchase Order (i.e. Inventory / Product Code / G/L Account) is identified, and
then from the Accounts Payable account. Next, Cash-Out from the Bank Account is identified.
Finally, if you have not set up the proper categories on the Cash Plan, the Cash-Out defaults to
the category for Other Accounts.
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You can edit categories. If you change categories, you need to recalculate so that the cash plan 
reflects amounts specific to the new or different categories.

Calculation Sequences
Cash-In and Cash-Out categories identify the cash source from a sequence of searches.

• Cash-In categories can identify the cash-in source first from the Customer Order (i.e. Revenue/G/
L Account), then from the Accounts Receivable account, then from the Bank Account, and finally,
if you have not set up the prior categories on the Cash Plan, the cash-in defaults to the Category
for Other Accounts.

• Cash-Out categories can identify the cash-out source first from the WIP Inventory accounts (work
orders that are linked to purchase orders), then from the Purchase Order (i.e. Inventory/Product
Code/G/L Account), then from the Accounts Payable account, then from the Bank Account, and
finally, if you have not set up the prior categories on the Cash Plan, the cash-out defaults to the
Category for Other Accounts.

In order to account for all cash movements, all cash accounts MUST have a Bank ID.

Discounts taken are included on the Cash Plan in the category line for customers and vendors.

For example; A customer takes a 2% discount on a $10,000.00 invoice for Gross Sales for 
Furniture. Cash Plan category line Incoming Cash from Gross Sales Furniture equals $9,800.00 
($10,000.00- 2%).

Take a 2% discount on a $10,000.00 invoice for the purchase of inventory. Cash Plan category 
line outgoing cash from inventory equals $9,800.00 ($10,000.00 - 2%).

ACTUAL CASH + PROJECTED CASH = (Current)

You can view Projected Cash as an overlay to Actual Cash or separately. Column headings 
change to indicate layers of Overlay.
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Starting the Cash Management Window
The Cash Management Window is available from the Ledger Menu of Financials.

To access the Cash Management Window:

1 Select Cash Management Window from the Cash menu.

The very first time you use this function, the window opens with an empty Plan Open dialog box, 
click the Cancel button to close.

After you have set up a plan or plans, the Plan ID names that you create are listed in the Plan 
Open dialog box. You can access the Plan ID by double-clicking on, or highlighting the Plan ID 
from the list and then clicking the Ok button. 

2 Click the New toolbar button, or select New from the File menu.

The Plan Save As dialog box appears.

3 Enter a unique Plan ID, and Description for your plan.

4 Click the arrow and select the Financial Calendar to use for this plan. By default, all sites that use 
the financial calendar you select are included in the plan. To select specific sites, edit the plan’s 
properties.

5 Click the Save button to trigger the Cash Management Category Wizard.

The Wizard guides you systematically to build and edit your Cash Plan categories.

You can also access the Wizard by selecting Show Category Wizard under the View menu of 
the Cash Management window, or by clicking the Wizard toolbar button.

You can click the Back button to revert back to the previous dialog box to make changes.

You can click the Cancel button at any time to exit the Cash Category Wizard without saving.

Adding Cash Categories
The Category Wizard is available to build your Cash Plan Direction categories for Incoming Cash, 
and Outgoing Cash.

1 After you have saved your cash plan, the Category Wizard opens the Cash Direction dialog box.

In the Category Cash Direction section, click the radio button that defines the type of cash this 
category is going to collect, either Incoming Cash or Outgoing Cash.

Incoming Cash – Incoming cash refers to money credited to your books.

Outgoing Cash – Outgoing cash refers to money debited to your books.

2 Click the Next button to open to the Category Account List dialog box.

The Cash Category Account List dialog box enables you to define your Account ID(s), list 
categories, and default categories for Other Accounts.
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You can enter one or more account numbers in your list, there are no defined limits. Type them 
individually or select the accounts from the list. To open the list, double-click the browse button in 
the Account ID column header.

The Multi-select Unlinked G/L Accounts dialog box appears.

You can narrow down the size of  the list by selecting the Account type you want to include: Asset, 
Liability, Equity, Revenue and/or Expense. When you select the Account type, only the accounts 
within that category or categories are listed.

You can select accounts three different ways:

• Select a continuous range by clicking the first account number you want to include, then press
and hold the CTRL key down, then click the last account you want to include. All the accounts
between the first and last account you selected are highlighted.

• To add non-consecutive accounts from the Account ID list, use the CTRL key and right-click
the Account IDs individually, or deselect account lines in a continuous group.

• Use the Search function to search the table for a specific account or series of accounts. Click
the Descending check box to sort the list in descending order if you know for example, that
the account you want is near the end of the list.

Continue to insert lines until your Cash Plan Account List is complete. Double-clicking the upper 
left corner of the Cash Planning window inserts a row above the current line. Pressing the TAB 
key inserts a row at the bottom of the Cash Plan. Use the Category Account List dialog box to 
activate the line item Account ID to manually enter without browsing. If you have entered wrong 
data, click the line and access the Wizard again to make your changes.

3 Click the Next button to proceed to the Category Name dialog box.

4 Enter the name for this category in the Category Name field.

5 Click the Next button.

The Category Summary dialog box allows you to review, and / or edit your input before saving.

6 When you have completed all the Account List categories that you want, click the Apply button.

7 Press the TAB key on your keyboard.  

The Category Cash Direction appears again.

You must have at least one Incoming Cash account and one Outgoing Cash account.  

8 Select the radio button you need, then click the Next button.

9 Repeat  Step 2 through Step 6.

10 After you are finished entering all information in your cash plan, click the Apply button in the 
Category Summary dialog box to save your plan.

11 Click the Cancel button to return to the Cash Management window.

Editing Cash Categories

You can edit any area of a Cash Management Plan.
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Existing Cash Management Plans

To edit any category of existing Cash Plans:

1 Click File, Open from the Cash Management menu and select the file you want to edit from the 
list.

2 Highlight the row that you want to edit and press the Edit Properties toolbar button, or select 
Options, Properties from the menu.

3 If you are licensed to use multiple sites, click the Site ID(s) arrow and select the sites to include in 
the plan. You can select any site, provided that the parent entities of the sites you select share the 
same financial calendar. If you are licensed to use a single site, this field is unavailable.

4 Make your changes and click the Ok button to save.

The system warns you that the currency ID has changed. The following dialog box is opened.

Click the Yes button to clear the Actual and Projected columns and save the Forecast with the 
new currency format. 

Click the No button to create a new cash plan with the current categories and clear the 
information in the window.

Click the Cancel button to return to the previous cash plan.

Cash Management Plan In-process

You can edit all areas of the Cash Management Plan from the Category Wizard dialog box.

You can access the Category Wizard dialog box at any time by clicking on the plan report line that 
you want to edit, and then clicking on the Show Wizard toolbar button, or by selecting View, Show 
Category Wizard from the menu.

To edit a Cash Management Plan in-process:

1 Click the Back button from any Category Wizard dialog box to go back to the dialog box that 
pertains to the area that you want to edit.

2 Make the edit(s) and click the Next button.

3 When you are finished editing, click the Apply button in the Category Summary dialog box.

Click the Cancel button to exit the dialog box without saving changes.

4 To return to the Cash Management window, click the Cancel button.

Calculating Cash Plans for Actual Cash Activity
After you have created the Cash Plan, the next step is to calculate for actual cash activity.

Data accumulates from actual cash applied against Sales and A/R and from actual checks entered 
through A/P and Payment Entry. Use this function to update and apply accumulated cash to the 
database.
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1 Select Edit, Update Actuals from the menu, or click the Update Actuals toolbar button.

2 Select the type of update you want to produce by selecting one of the following radio buttons.

Bring Actuals Up to Date – Actual totals for each account specified to present are included.

Recalculate a Specific Date Range – Choose starting and ending dates for the calculation of 
balances.

3 If you chose to recalculate a specific date range, click the Calendar button to select a starting 
date, or enter the starting date in the field provided. 

Select an ending date by clicking on the Calendar button, or enter the ending date in the field 
provided.

Both the actual cash transactions that you specify on the cash plan are calculated and 
categorized.

4 Click Ok to calculate or Cancel to exit without recalculating.

In the cash plan, the Beginning Balance plus Cash-in minus Cash-out equals the Ending Balance. 
If you set up the Cash Window to include the correct starting balance and all account activity and 
you entered the monthly cash transactions properly, the Ending Cash Balance should balance 
with the Financial Statement Ending Cash Balance for the end of that period.

5 Select Edit, Update Projections from the menu (or click the Update Projections toolbar button) 
to predict cash flow by incorporating current Accounts Receivable, firmed and released Customer 
Order lines, current Accounts Payable and firmed and released Purchase Orders in your cash 
plan.

Customer order lines are considered released if one of these conditions is met:

• The customer order line has a status of Released

• The customer order header has a status of Released and the customer order line has a status
of Inherit.

Customer order lines are considered firmed if one of these conditions is met:

• The customer order line has a status of Firmed

• The customer order header has a status of Firmed and the customer order line has a status of
Inherit.

You can display each component of the cash plan (actual, projection or forecast) separately or 
together. When you combine components the following rules apply:

A period that contains only actual amounts is an Actual period.

A Projected period contains no Actual cash transactions.

A period that contains actuals and projections is the Current period (at the time the cash plan was 
generated). The update of actual cash deletes previous projections within its time frame and 
projected cash can never be projected before “today.”

A period that contains only forecast amounts is a Forecast period.

A period that contains projections and forecast amounts is a Prj & Frc period.
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Calculating Cash Plan Projection Assumptions
The current contracts (open documents) found in A/R Invoices, released and firmed customer order 
lines, A/P Vouchers and Purchase Orders are the base for calculations of projected cash. 

Customer order lines are considered released if one of these conditions is met:

• The customer order line has a status of Released

• The customer order header has a status of Released and the customer order line has a status of
Inherit.

Customer order lines are considered firmed if one of these conditions is met:

• The customer order line has a status of Firmed

• The customer order header has a status of Firmed and the customer order line has a status of
Inherit.

Receivables are the anticipated “cash-ins” from open receivables on the A/R Aging Report.

1 On the Cash Management window, click the Update Projection toolbar button, or select Edit, 
Update Projections. 

2 Click the Receivables tab to permanently set your criteria pertaining to Accounts Receivable 
projections.

3 To include Receivables in your projection, click the Include A/R invoices in the Projected Cash 
dialog box. Receivables make up the anticipated “Cash-in” from Open Receivables as seen on 
the A/R Aging Report.

4 Use the radio buttons in the Assume Customers Will section to select the choices that apply to 
your plan:

In order to ensure accurate results, be sure to override the “0” defaults.

Pay consistently (use ___ samples) – This option calculates what the customer will pay in the 
future based on their history. For each customer, a percentage over / under term is determined 
based on a specified number of sample invoices. This percentage is applied to future invoice 
terms to determine when cash will be received.

Pay terms +/- ___ days – this option determines a specified number of days, adds or subtracts 
days from each invoice term, and then applies this payment performance to the open Receivables 
Cash-In projection.

Pay in ___ days – This option overrides all invoice terms and calculates payment projection for 
all invoices for a specified number of days.

Pay on-time – This option calculates payment projection according to net terms of all open 
receivable invoices.

5 To ignore specific invoices in your projection, select the choices that apply to your plan:

Ignore Invoices Due Earlier than a Specified Number of Days – Select this option to ignore 
invoices from the Cash-In Receivables projection prior to the number of days specified.

Ignore Invoices Due Later than a Specified Number of Days – Select this option to ignore 
invoices from the Cash-In Receivables projection after the number of days specified.

The specified invoices are considered past due, dead, or as having terms due in the future.
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6 To view account payment information, outside of the Update Projected Cash dialog, select File, 
Print Pay Performance from the main menu. 

You can print, view or send this report that lists all payment information on any account(s) you 
choose to include. Refer to “Printing Pay Performance Reports” on page 2–13 for more 
information.

7 Click the Customer Orders tab.

Customer Orders is the anticipated “cash-in” from firmed or released customer order lines.

8 Click the Include Customer Orders in Projected Cash check box to include customer order 
lines in your projection.

9 There are two payment assumptions that you can select to form the basis for your projection:

Ship consistently (use _ samples) – This option calculates projected “Cash-in” from customer 
orders based on your past product (code) shipment performance. For each product code, an 
average number of days over/under the actual lead time is determined based on a specified 
number of sample shipments.

This average applies to future shipments of the same product code to determine when products 
are shipped.

Ship On-time –  This option calculates projected “cash-in” from customer orders according to the 
“desired” or ”line item ship date” on the order.

10 Ignore Invoices Due Earlier Than a Specified Number of Days – Select this option to ignore 
invoices from the Cash-In Customer Orders projection prior to the number of days specified.

Ignore Invoices Due Later Than a Specified Number of Days – Select this option to ignore 
invoices from the Cash-In Customer Orders projection after the number of days specified.

The specified invoices are considered past due, dead, or as having ship dates in the future.

11 Click the Payables tab.

Payables is the anticipated “cash-out” from open payables as seen on the A/P aging report.

12 To include payables in your projection, check the Include A/P Invoices in Projected Cash check 
box. There is a set of payment disbursement assumptions you can select from as a basis of your 
projection.

Pay by schedule – This option calculates projected cash-out based on the payment schedule in 
Check Generation and Print.

Pay terms +/-  – This option specifies a number of days that adds and / or subtracts days from 
each voucher term and then applies this disbursement performance to the open payables cash-
out projection.

Pay in number of days – This option overrides all voucher terms and calculates payment 
disbursement projections for all vouchers for a specified number of days.

Pay on-time  – This option calculates payment disbursement projections according to net terms 
of all open payable vouchers.

13 Click the Purchase Orders tab.

The Purchase Orders tab appears.
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Purchase Orders are the anticipated “cash-out” from firmed or released purchase orders.

14 To include Purchase Orders in your projection, check the Include Purchase Orders in Projected 
Cash check box.

15 You can select from two payment disbursement assumptions as a basis for your projection.

Receive Consistently (use _ samples) – This option calculates future cash-out from purchase 
orders based on the vendors past delivery performance. For each vendor, an average number of 
days over / under the receiving performance (due date compared to actual receive date) is 
determined based on a specified number of sample receipts.

This average applies to future orders of the same vendor to determine when you can expect to 
receive products.

Receive On-time  – This option calculates projected cash-out from purchase orders according to 
the desired or line item receive date on the order.

16 Expect Invoice a Specified Number of Days After Receipt – Select this option to calculate the 
number of days between receipt of material and receipt of invoice, and add / push out the terms of 
payment disbursement by that number of days.

17 Ignore Purchases Due Later Than a Specified Number of Days – Select this option to ignore 
or delete orders from the cash-out purchase orders projection.

These orders are considered past due or dead.

18 After you have determined your projection, click the Ok button to calculate or the Cancel button to 
cancel.

You can add forecast amounts to speculate future cash flow beyond the point in time where 
contract documents (invoices, vouchers, customer, and purchase orders) do not exist or are 
insufficient. Forecasted Cash can overlay Projected Cash or you can view each separately. Actual 
Cash entered in a period prevents Forecasted Cash from overlaying Projected Cash. Column 
headings change to indicate layers of Overlay.

Cash Plan Header Summary

Actual = Transactions in cash accounts

Current = Actual + Projected Cash

Projected = Projected balance only (Assumed)

Prj & Frc = Projected + Forecasted cash

Forecast = Forecasted cash only

19 Select Edit, Edit from the menu to edit your projection.

You can insert / delete rows (categories) and columns (periods) and Copy row right. Actual and 
projected viewing at this point is deselected.

20 Click the Insert Column button.

After the first column is added, you can enter your forecast amounts by category for the current 
period.
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Adding another column generates a forecast column for the next period. After you enter an 
amount in a field, you can use the Copy row right option to copy that same amount to the next 
column / period.

21 You can display each component of the cash plan (actual, projection and/or forecast) separately 
or together. The header of the column indicates which components are active.

22 Select File, Print Receipt Performance from the menu to review the purchase orders included in 
your projected cash.
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Viewing the Cash Plan Graph
You can view the amounts in your cash plan in a graph.

To view the graph, click the Graph button. The graph is opened.

To view the graph and the cash management table at the same time, click the Restore button in the 
title bar.

When you first display the graph, the ending balance is shown. To view a different category, select 
the category in the table.

To view multiple categories, press CTRL, then click the categories to view. Each category is 
represented by a different bar color. 
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Printing Cash Plan Reports
A series of reports created from the information that you set in the Cash Plan are provided. There are 
four report options, you can select Print (Cash Plan), Print Pay Performance, Print Shipment 
Performance and Print Receipt Performance. Use the reports to gain vital in-depth information.

Printing Cash Plan Reports
Use the Cash Management Plan Report to output the information as displayed and calculated on the 
Cash Management Plan.

1 Select File, Print from the menu.

2 Select the output type from the drop-down menu.

Choose from one of the following:

Print – Select this option to output the file to a printer.

If necessary, change the printer setup by clicking on the Print Setup button and making the 
changes.

View – Select this option to see what the printed output will look like before you print it.

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-mail – Select this option to send the report as an .RTF (rich text file) attachment through 
Microsoft Outlook.

3 If you chose Print, click on Ok.

The Cash Management Plan Report is printed.

If you do not want to print, click the Cancel button to exit the dialog box without printing the report.

Printing Pay Performance Reports
Use the Pay Performance Report option as a customer “Credit Status” report. The report lists the 
Customer ID, Customer Name, Company Contact, Phone Number, FAX Number, Sales Rep, Credit 
Status, Terms and the Average Payment Days Over/Under Terms.

1 Select File, Print the Pay Performance from the menu.

2 Click the Browse button to select a Starting and Ending Customer ID, or enter the Customer ID in 
the appropriate field.

To include all Customer IDs in the report, leave both fields blank.

3 Select the output type from the drop-down menu.

Choose from one of the following:
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Print – Select this option to output the file to a printer.

If necessary, change the printer setup by clicking on the Print Setup button and making the 
changes.

View – Select this option to see what the printed output will look like before you print it.

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-mail – Select this option to send the report as an .RTF (rich text file) attachment through 
Microsoft Outlook.

4 To include only a specified number of transactions, fill in a numeric value in the Use ___ samples 
field. The last “ # ” of payments is printed.

5 If you chose Print, click the Ok button.

The Pay Performance Report is printed.

To exit the dialog box without printing the report, click the Cancel button.

Printing Shipment Performance Reports
Use the Shipment Performance Report option to summarize by Product Code the average days 
before and / or after the desired ship date that the orders actually shipped.

1 Select File, Print Shipment Performance from the menu.

2 Click the Browse button to enter the Starting and Ending Product Code, or enter the product 
codes in the appropriate fields.

To print all Product Codes, leave both fields blank.

3 Select the output type from the drop-down menu.

You can select one of the following:

Print – Select this option to output the file to a printer.

If necessary, change the printer setup by clicking on the Print Setup button and making the 
changes.

View – Select this option to see what the printed output will look like before you print it.

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-mail – Select this option to send the report as an .RTF (rich text file) attachment through 
Microsoft Outlook.

4 If you want to include only a specified number of transactions, fill in a numeric value in the field 
labelled Use ___ samples. This prints the last “ # ” of shipments.

5 If you chose Print, click the Ok button.

The Shipment Performance Report is printed.
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To exit the dialog box without printing the report, click the Cancel button.

Printing Receipt Performance Reports
Use the Receipt Performance Report option to review the merchandise receipt date. The report 
includes the Vendor ID, Vendor Name, Buyer, Company Contact, Phone Number, FAX Number, 
Terms with the Average Days Before/ After the desired receive date that the merchandise was 
actually received.

1 Select File, Print Receipt Performance from the menu.

2 Click the Browse button to enter the Starting and Ending Vendor IDs, or enter the vendor IDs in 
the appropriate fields.

To include all Vendor IDs in the report, leave both fields blank.

3 Select the output type from the drop-down menu.

You can select one of the following:

Print – Select this option to output the file to a printer.

If necessary, change the printer setup by clicking on the Print Setup button and making the 
changes.

View – Select this option to see what the printed output will look like before you print it.

File – Select this option to save the report to a text file. You can then edit the file using any text 
editor.

E-mail – Select this option to send the report as an .RTF (rich text file) attachment through 
Microsoft Outlook.

4  If you want to include only a specified number of transactions, fill in a numeric value in the field 
labelled Use ___ samples. This prints the last “ # ” of receipts.

5 If you chose Print, click the Ok button.

The Receipt Performance Report is printed.

Click the Cancel button to exit the dialog box without printing the report.
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Bank Account Maintenance
Chapter 3: Bank Account Maintenance

Use Bank Account Maintenance to enter and maintain account information about your bank and 
ledger accounts relative to receivables and payables. In Receivables Cash Application, Bank Account 
information is used to track Receipts. In Payables, the same information is used to track Payments. 
You can enter an unlimited number of Bank Accounts in Cash Book. For more information, refer to 
Chapter 1, “Cash Book”.

The need to transfer currencies between banks for businesses that deal with European transactions 
is handled in Financials. You should set up bank accounts of different currency denominations; this 
gives you the ability to receive monies in a customer’s normal currency as well as the ability to pay 
vendors in their native currency.

If you are licensed to use multiple entities, each bank account can be associated with one entity only. 
Any site that belongs to the entity can use the bank account.

This chapter includes: 

Topic Page

Starting Bank Account Maintenance............................................................................................... 3–2

Specifying User Dimensions........................................................................................................... 3–5
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Starting Bank Account Maintenance
Bank Account Maintenance is available from the Main menu.

Select Cash, Bank Account Maintenance from the menu.

Adding Bank Accounts
Use Bank Account Maintenance to add bank accounts to the database. You may want to establish 
separate Bank Accounts for specific currency denominations to track Euro receipts and payments.

1 Click the New toolbar button, or select File, New from the menu.

2 Enter a Bank Account ID for the bank you are adding in the Bank Account ID field.

The ID can be up to 15 characters.

Because the ID is your unique identifier for the bank account, it does not have to correspond to 
the Bank Account number.

3 Press the TAB key and enter a description for the Bank Account in the Description field.

This is not required but is helpful if you have a large number of bank accounts.

4 Click the Browse button beside the G/L Account ID field to enter the G/L account ID you want to 
assign to this bank, or enter the G/L Account ID in the field provided.

This is the account to which you post the A/R Deposits and A/P Checks.

The name of the G/L account selected appears beside the field.

5 Click the arrow beside the Entity ID field to select an accounting entity from the list.

The name of the Entity selected appears beside the field. Only the sites associated with this entity 
can use the bank in transactions.

6 Click the Browse button beside the Currency ID field to select a currency ID from the list, or enter 
the Currency ID in the field provided. You can select any currency that has been assigned to the 
entity.

The name of the currency selected appears beside the field.

The currency represents the currency of the account. After a payment or a receipt has been made 
or applied to the Currency ID, you cannot edit the field.

7 Click the Address tab from the Bank Account Maintenance window.

8 Enter the necessary information for the bank in the following fields:

Bank Account ID – The unique identifier for the bank account.

The Bank Account ID is automatically populated from the General tab.

Description – The description of the bank account.

The Description is automatically populated from the description entered in the General tab.
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Starting Bank Account Maintenance
Name, Street Address, City, State, Zip code and Country – The bank name and address to 
which the bank account belongs.

9 Click the Payment tab from the Bank Account Maintenance window.

10 Enter the following information, if necessary, in the Payment tab.

Bank Account ID – The unique identifier for the bank account.

The Bank Account ID is automatically populated from your entry from the General tab along with 
the Bank Account description.

Description – The description of the bank account.

The Description field is populated from the description in the General tab.

Bank ID – Enter the unique bank identifier for the bank account.

Account # – Enter the bank issued account number.

Routing Number – Enter the bank routing number in the field provided. This field is required by 
your bank.

Account Type – Enter the bank issued account type. Maximum 2 characters.

Branch ID – Enter the bank issued sort code or branch ID.

Transmit User ID – Enter the transmission (BACS) user ID.

Pay Export ID – Click the Browse button to select a Pay Export ID from the list, or enter the Pay 
Export ID in the field provided.

To define Electronic Payments, checks are used to support payment receipts and disbursements. 
Vendor payments can take electronic form. This involves direct access provided by a third party 
software package that connects to the bank or a clearing house via modem or other on-line 
connection. When you create an export file, the export file method is supported. In addition, 
BACS is also supported, a United Kingdom bank clearing and electronic funds method.

XML – If you selected an export format that is in XML format, the system selects the XML check 
box.

IBAN – Enter the International Bank Account Number for this bank.

BIC – Enter the Bank Identification Code for this bank.

11 After you enter all the information in all the tabs, click the Save button.

Editing Bank Account Information
Use Bank Account Maintenance to edit bank account information. After you add the bank account, 
you can edit all of the information in the Bank Account Maintenance window with one exception. 
When a payment or receipt has been applied to the account, you cannot edit the Currency ID field.

1 In the header, click the Browse button beside the Bank Account ID field and select the account 
you want to edit.

2 Make any necessary changes.
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You can change any field in the Bank Account Maintenance window except Currency ID.

3 Click the Save button to save your changes.

Deleting Bank Accounts
Note: Deleting a bank account permanently removes the information from the database. It is NOT 
recoverable. If there are transactions that reference the Bank Account ID in the database, you cannot  
delete the bank account.

You can use Bank Account Maintenance to delete bank accounts that are in the database. You can 
delete only those Bank Accounts that do not have any transactions posted against it.

1 Click the Bank Account ID browse button and select the bank account to delete. 

2 Click the Delete button.

A dialog box appears, asking you to confirm the deletion.

3 Click the Yes button to continue the deletion, or the No button to cancel.

The bank account is removed from the database and the fields are cleared.
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Specifying User Dimensions
If you use dimensional reporting, you can attach user dimensions for bank accounts to these 
transactions:

• A/P Payments

• A/R Payments

• Bank Adjustments

You can set up different user dimensions for each bank account. Use the User Dimensions for Bank 
Account dialog box to specify which user dimensions to associate with a particular bank account. Use 
the User Dimensions Priorities dialog box available in the Accounting Window to determine when the 
bank account user dimension IDs should be used. See "Cost Centers" on page 2-1 in the General 
Ledger guide.

To associate user dimensions with bank accounts:

1 Select Edit, User Dimensions....

2 In the left pane, each user dimension group is listed. Expand the list under the user dimension 
group to view the transactions in which bank account user dimensions can be used. 

To assign the same dimensions to all transaction types, click the name of the dimension group in 
the left pane. All Subledgers is inserted in the Subledger field.

To assign dimensions to a particular transaction type, select the appropriate transaction type. The 
transaction type is inserted in the Subledger field.

3 Click Insert.

4 Specify this information:

Valid From – Specify the date the dimension assignment becomes effective. 

Debit Dimension – Double-click the browse button and select the dimension to use for account 
debits.

Credit Dimension – Double-click the browse button and select the dimension to use for account 
credits.

Click Save.
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